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1. Software License Agreement 
 

1.1 Acknowledgement 

At ScreenCheck we are committed to design and develop the highest quality 
software and service. 
We would like to thank all the people who have contributed their talent, intellect 
and heart to produce this product. 

1.2 Copyright 

Information in this document is subject to change without prior notice and does 
not represent a commitment on the part of ScreenCheck. The software, which 
includes information contained in any databases, described in this document is 
furnished under a license agreement or nondisclosure agreement and may be 
used or copied only in accordance with the terms of that agreement. It is against 
the law to copy the software except as specifically allowed in the license or 
nondisclosure agreement. No part of this manual may be reproduced in any form 
by any means, electronically or mechanical, including photocopying and 
recording, for any purpose without the written permission of ScreenCheck B.V.. 

© 1993-2006 ScreenCheck B.V., All rights reserved. 

Printed in the Netherlands, Europe. 

1.3 Trademarks 

Badgemaker, BM3400, BM4400, BM5400, BM5500, BM6000, DBLC, BC and 
Visipass are trademarks of ScreenCheck B.V., The Netherlands. 
Windows is a trademark of Microsoft Corporation.  
All other trademarks are the property of their respective holders and are hereby 
acknowledged. 

1.4 System requirements 

System requirements BadgeMaker systems 
BM requires Microsoft Windows 2000 or XP to run and can be used on any IBM 
compatible computer that meets the following minimum requirements: 

• Pentium III 1 GHz Processor or better. 
• 4GB hard disk space recommended, actual size depending on number of 

records and images in the database. 
• 256Mb or more internal memory. 
• Colour monitor and graphics card with support of at least SVGA resolution 

of 1024x768 pixels and 24 bit (true) colours. 

1.5 Release notes 

In the release notes the latest modifications are described grouped by version 
number. You can find the release notes in the BM5500 program folder. 
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2. Installation 
The BM5500 software can be installed from the ScreenCheck BadgeMaker CD. 
This CD will run automatically (if it does not, start the ‘autorun.exe’ in the root 
directory of the CD) and will come up with a menu.  
 
Select BadgeMaker software from the menu and then BM5500 32 bit software 
from the next menu. 
The installation program will be started. The information in the installation 
dialogues will guide you through the installation. Make sure to install the other 
components as well (camera software and/or printer driver) when applicable. 
Restart your PC after the installation. Now your system will be ready to use. 
 
BadgeMaker will also install an MSAccess demo database. If you select ‘Demo 
Data Source’ from the program folder, the ODBC registration for this database 
will be done automatically. When that is finished, you can work with the demo 
database right away. 
 

 Make sure you have administrator rights when you install on a Windows 2000 
or Windows XP workstation. 
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3. Introduction 
This manual is intended to guide the beginning user of BadgeMaker through the 
process of producing basic cards. The necessary steps are described in the order 
as they have to be followed to produce cards. The more advanced options of 
BM5500 can be found in the reference manual and the help file.  

The BadgeMaker software consists of three components integrated in one 
package. Each component has its own functionality. 

DBLC: This module is used to create a project file with database and image 
settings and references to all the files used by BadgeMaker. 
 
BC: This module is used to create badge layouts, with static text, fields from the 
database (normal as well as bar-coded), logos, photos, signatures, magstripe 
information and chip encode information (Badge Creator). 
 
BM: This module is used to produce badges with the dynamic, static or encoded 
data according to the settings defined in DBLC and layouts created with BC 
(Badge Maker). 
 
The system administrator uses DBLC to set up the system, he/she can also define 
the layouts or this can be done by the user. Once the settings are made and the 
layouts are created the only thing the user needs is the BM module to produce 
the cards.  
 
With BM5500 an MSAccess demo database is included that shows most features 
of the software. The installation program will install the demo files and will 
register the ODBC data source, so it will be ready to run. You can use the demo 
database as a reference when you create your own BadgeMaker project or you 
can test different features you would like to integrate in your own project. 
 
When you create a new project there are three steps to make in order to produce 
cards: 

• Step one: create a project file (chapter 4). 
• Step two: create one or more layouts (chapter 5). 
• Step three: manage your card data and produce cards (chapter6). 

 
In the following chapters the three steps to set up your project will be described. 
 

  If the system supervisor already has set up a 
BadgeMaker project and if the card layouts are already 
made, you can skip chapter 4 and 5 and start directly at 
chapter 6 for the production of cards. 
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4. Step 1: Create a project file and define the 
settings 
For Microsoft databases (e.g. MSAccess, SQL server) and some other popular 
databases an ODBC driver is already available in Windows. For other databases 
like Oracle and Pervasive a client with ODBC driver should be installed on the 
workstation in order to be able to make an ODBC connection. If you are unsure if 
the correct software is installed, consult your database administrator about this 
issue. 
 
When you wish to connect to a database on your PC or on your network, you 
should first register this database with the ODBC data source administrator 
(control panel or DBLC). 
 

4.1 Create a project file 

Start BadgeMaker and click the ‘Login’ button  or select ‘Login’ from the 
‘User’ menu. The login dialogue will come up: 
 

 
 
Give in your user name and password.  
After the first time installation of BadgeMaker, you can login with the user name 
‘SUPERVISOR’ and password ‘SUPERVISOR’. This user has administration rights. 
 
Select ‘New’ from the ‘File’ menu. The DBLC module will be started. to create a 
project file with the settings for BadgeMaker by selecting Database Layout 
Creator from the program folder. 
The ‘Select data source’ dialogue will be displayed. Click on the ‘Machine data 
source’ tab: 
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Select the DSN name if the database is already registered in ODBC or click ‘New’ 
to register a new database.  
Select ‘User Data Source’ and click ‘Next’. 
Select the name of the database driver and click ‘Next’. 
Read the information in the window and click ‘Finish’. 
 

Now the ODBC setup dialogue will be displayed. This dialogue will differ 
depending on the selected ODBC driver.  

 
Although the dialogues are different for the various ODBC drivers a data source 
name must always be entered (a description is optional). In the sample for the 
Microsoft Access database a database (.mdb) file can be selected. For an Oracle 
database installed on a server however a user and server have to be entered: 
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Create a new project file: 
Once the connection is made, a new project file can be created. Select ‘New’ from 

the file menu or click the  button. After selecting this option the ‘Tables’ 
dialogue will come up: 

 

In this dialogue the available tables, queries and views from the connected 
database will be presented. Select the table, query or view where the data can be 
found for creating the badges and then click ‘OK’. Since BM5500 connects to only 
one table, query or view for retrieving the card data, make sure that all necessary 
information for creating your ID cards is available. 
Make sure in advance that this table has a unique field that also can be used as 
an ID for the images in the picture table.
After clicking OK the fields from this table will be read and filled in the main 
dialogue, at the same time a new dialogue, ‘Step 1: General settings’, will come 
up. When a new BM file is created, the environment settings have to be made in 
four steps. The first step is to fill in the project name and make the settings for 
the image quality, thumbnail and ldap support. 

• Project name: Fill in a name for the project. 
• Image quality: The ‘Default Image quality’ results in a good quality picture 

and a moderate image size. Refer to the help file or full BM5500 manual 
for more detailed information. 

• Thumbnail image: Check this option to create a 256 colours bitmap image 
with reduced resolution apart from the standard generated jpeg image 
(use this option only if you would like to show images with an application 
that cannot display jpeg images). This option can only be used to create a 
bitmap copy of the photo and signature. 

• Ldap support: Check this option if you use an ldap database (this option is 
necessary since the ldap ODBC driver is not completely compliant with the 
ODBC standards). 

 
Click next to go to the ‘Step 2: Image types’ dialogue. 
By default BM5500 reserves 4 images types: photo (type 1), signature (type 2), 
photo thumbnail (type 3), signature thumbnail (type 4). 
Use this dialogue to add if you wish additional images types to your project (e.g. 
fingerprint image). Apart from the four existing types, you can add 16 extra 
image types. In this way you can use BadgeMaker also to create a database of 
objects (e.g. real estate) with multiple images. 
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 The image types 1 – 4 cannot be removed from the system. If you select one 
of them the ‘Remove’ button will not be accessible. 

 
Use custom size thumb nails 
If you use the thumb nail option, thumb nails of the photo and signature can be 
stored. For more details refer to the full version of the manual. 
 
Click ‘Next’ to go to Step 3, the  ‘Special tables’ settings where you can select the 
image table and select a logging table (if required). 

Step 3: Special tables 

 
 

Store images in this table: Select here the table that will be used to store the 
images in. This table has to have a fixed structure. Refer to ‘Structure of the 
image table’ on the next page for a description how to set up this table in your 
database. 
 
Log mutations in this table: If you want to keep track of the mutations made 
in BadgeMaker a logging table can be kept. Select here the table to log the 
mutations in. Refer to the full version of the manual for details on logging. 
 
Structure of the image table: 
BM5500 stores images as BLOBs (binary large objects) in a table in the database. 
This has the advantage that you only have to backup your database, alpha 
numeric fields can be used as photo and signature ID and you have the option of 
storing thumbnail pictures and signatures. If you select this option, a table must 
be selected by clicking the ‘Select Table’ button. If a table is selected without the 
appropriate structure an error message will be displayed. 
 
The picture table must be created using the database management system of 
your existing database (e.g. MSAccess, Oracle, SQL Server, Sybase etc.). The 
name of the table is free to select (e.g. Pictures, Images or else), but the table 
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must consist of 4 fields with fixed names and fixed types in a fixed order. See 
table below: 

 

   Picture Table : 

  Field Name  type   length  

  ID      : Alpha numeric  8 or more 

  Length  : Numeric  8 or more 

  Picture  : Long Binary   

  Type   :  Numeric  2 or more 

 
The type can be different depending on the database used. In MSAccess the 
numeric fields can be Long Integers, the pictures must be of the type ‘OLE 
object’. In Oracle the type for the pictures is ‘Long Raw’. 
 

 Note:  The ID field in the Picture table is not unique; the same ID can be 
used with up to 20 types of pictures (photo, thumbnail photo, signature and 
thumbnail signature). ID and Type fields together are unique (a combined index 
can be made). Don’t create a relationship between the tables. 
 
Below the link between the database table and the picture table is displayed. 
BadgeMaker will take care of the link between the photo or signature ID in the 
database table and the ID field in the picture table. 
 

 

Click ‘Next’ to go to the ‘Step 4 dialogue’ (special fields) or click ‘Back’ to change 
the ‘General Settings’. 
 
Step 4: Special Fields 
 
Specify a unique field: Select a unique field from the database (by clicking the 
drop down list). When an image is stored in BadgeMaker, BM will copy this value 
in the field ‘ID’ of the images table. Together with the field ‘type’ this will identify 
the images stored in the database (images table).  
 
Register tagged records in this field: If you would like to use the option ‘tag 
records’. A field has to be selected to register the tagged records. An unused 
numeric field in the database can be used for this purpose. If this is not available 
a field has to be added to the database. This field is not mandatory, but if it is not 
defined the option to tag records cannot be used. For an explanation of the option 
‘tag records’ refer to the BM5500 part of the manual. 
 
Store layout description in this field: If the ‘Automatic layout’ option is used a 
field has to be selected where to read the layout description from (the layout 
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descriptions as displayed in BM in the layout selection dropdown list should match 
the values filled in this field). You only need to select a field if you intend to use 
the automatic layout option. 
 
Now click ‘Next’ to go to step five. 
 
Step 5: Image files 

 

BM5500 stores images in an image table, but it can read image files from the 
hard disk or from a CD Rom. Check this option if you have ready made image 
files. The name of these image files must correspond with the value in the field 
specified in step 4 under ‘Specify unique field’. 

Read images from folder 
In case you already have ready made image files on CD-Rom or hard disk, you 
can use the option ‘read images from folder’ to access them. This option is read-
only, so new captured images cannot be stored as files, but will be saved in the 
image table of the database. If an image with the same name exists as well in the 
image table as image file, the image in the image table will have priority over the 
image file. 

After checking the option ‘read images from folder’ you have to select the image 
file folder. Note that the different types of images must be stored in the folder 
according to their image type number: 
 
The image folders 3 and 4 will not be used (since these are thumbnail images of 
the types 1 and 2). If you add new image types, the first new image type is type 
‘5’, the second will be type ‘6’ and so on. 
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If the images come from a 16 bit BM5000 or BM5500 system, images were stored 
in a number of sub folders. In that case specify also the number of sub folders. 
Since BadgeMaker used a special algorithm to calculate the sub folder, this option 
will probably not work with files in subfolders created by other systems. 

If the image files are divided over a number of sub folders, fill in the number of 
folders in the box ‘number of sub folders’. 
 
In case the image file has a number, the sub folder will be determined as follows: 
 
Remaining value of: (image file number)/(number of sub folders). 
 
In case the image file name is 56784234.JPG (or 56784234.JIF) and the number 
of sub folders is 10, the image file must be placed in the sub folder 4. 
This is the same way as the files were handled in the 16 bit versions of 
BadgeMaker 5000 and 5500. 
 
In case the image files have a name in letters, BadgeMaker will search all sub 
folders. However note that this will result in a longer retrieving time. 
 
Step 6: MM integration (optional). 

Fill in the parameters for MM integration if applicable or just click ‘Next’ to skip 
this step. 

Step 7: Folders 

BM file folder   Location of the BM-file. 
Card layout folder Location of the badge layouts files. 
Encode layout folder Location of the encode files for magstripe and chip 

encoding. 
Logos folder   Advised location of the logos used on badge layouts. 
 
 

You can change the location of the files by: 

1. Clicking on the button of the subject you want to change. A directory 
structure will be shown: 
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Selection of the desired folder can be done in the same way as in 
the Windows Explorer, then click OK. 

2. Or fill in the path directly. 
 

After the selection of the folders, click ‘Finish’ to close the dialogue and save the 
settings.  
 

4.2 Defining the settings 

When a new BM-file is created or an existing BM-file is opened the field 
information of the ‘main’ table will be displayed in this dialogue: 

 

 
 

By default all fields are ‘view only’ for BM5500 if a new BM-file is created. By 
double clicking on a field some properties for use in BadgeMaker can be changed. 
The same can be done by selecting ‘properties’ from the edit menu. 
 
The properties dialogue consists of three tabs where for every field a number of 
properties can be set: 

Miscellaneous tab 

Field description: The field description is displayed in BM on top of the field 
columns (in the multi record view) and in the edit box. It can be edited by filling 
in another description in the input box. The actual field name cannot be changed 
in DBLC, this can only be done with the database management system of the 
used database (MSAccess, Oracle, SQL Server etc.). 
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Restrict input: This option is only available if a field is a text field. Input 
restrictions are used for magstripe encoding to prevent that data is inserted (in 
BadgeMaker) that is not allowed on the magnetic stripe.  

Log this field: Check this option if the contents of this field has to be stored in 
the log table. 

Field style: Select whether the field must be invisible, view only or editable in 
BM5500. 

Pick list tab 

Has pick list: This option can be activated only when a field is ‘editable’. If this 
option is active a list of items can be created to select from in BM5500. For 
example a list of all available departments can be created to fill in in the field 
‘Department’. 

Has logo: This option can be activated only when the option ‘Has pick list’ is 
checked. It can be used to link a logo to an item in the pick list. Refer to the full 
manual version for more details. 

Default value: In this input box a default value can be filled in that will be used 
in BM5500 when a new record is created. When a pick list is used an item from 
the list has to be selected as default value with the ‘Default’ button. 

New item: Type in a new item for the list in this input box. 

Add to list: Use this button to add the new item to the list. 

List of items: In this dropdown list the already available items can be displayed. 

Drop: Use this button to remove a selected item from the list. 

Default: Use this button to make the selected item the default value for this 
field. 

Edit: Use this button to edit the selected item from the list. 

 

Auto update tab 
Use this option to let BadgeMaker fill field values automatically triggered by an 
event.  
This option can only be enabled when the field style ‘View only’. For more details 
refer to the full version of the manual. 
Once the settings for each field are defined, you can save the project by selecting 

‘Save’ from the file menu. You can also click the ‘save button’ . 
If you were editing a new BM-file, you will see the same dialogue as in Save As. 

Save 
With the ‘Save as’ option you can save either a newly entered file or an existing 
file using another name. You are prompted to enter the name of the BM-file. 
If the name you selected already exists, you will get a warning. Click ‘Yes’ to 
replace the existing file or click ‘No’ and select another name. 

Exit 
After saving the project file you can exit DBLC.  
Mouse: Click the close button in the right top corner. 
Key: ALT+F4 
Menu: File menu|Exit 
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5. Step 2, creating badge layouts. 
In the previous chapter was described how to create a project (BM) file with the 
necessary settings for BadgeMaker. In this chapter will be explained how to 
create badge (card) layouts.  
It is not possible to create a card layout before a project file was created (see 
step 1).  
 
In BadgeCreator different kinds of layouts can be created : 
1. Badge layouts (in Badge Layout Mode)  Graphic design of the badge 
2. Magstripe layouts (in Magnetic Layout Mode) Definition of information to encode on 

       the magstripe. 
3. Chip layouts (in Chip Layout Mode)    Definition of information to  

       encode on the chip. 
4. Contactless chip layouts    Definition of Mifare and Legic

       chip layouts. 
5. OMC layouts     Definition of information for 

       optical memory card. 
 
NB: In this manual only the badge layout mode will be described! For other 
layout types see the reference manual. 
 
Select ‘New badge’ from the ‘File’ menu in BadgeMaker to start the BC 
component. The ‘Layout wizard’ will come up: 

 

 
 
Select the layout type you wish to create and click ‘Next’. The following screens 
are depending on the layout type you selected. Follow the instructions in the 
screens and fill in the required options. After running the layout wizard, you can 
add items to your layout. 
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If you click cancel, you will see the empty BC screen. BC has its own menus and 
buttons. 
 
Select ‘New Layout’ from the ‘File’ menu to start creating a new layout.  
The ‘New Badge Layout’ dialogue will be displayed. 
 

 
Layout tab:
 
Name Type the description of the layout, as you want it to 

appear in the layout selection box in BadgeMaker, for 
example:  “Employee badge” 

 The name can be up to 30 positions, however not all 
positions can be displayed in the layout selection list 
in BM. 

  
Include Back 

Check this option if you want to create a layout for 
both the front and the back of the card (this is only 
useful when your printer supports dual side 
printing). 

 
Background Color Front/Back 

With these options the background color for the front and the back 
(if the option ‘Include back side’ is checked) of the card can be 
selected. By default no background color (white) is selected. 

 
Magnetic Stripe Positioning 

If an ISO card format is selected, the position of the 
magstripe can be displayed on the back of the card. 
This can be helpful to prevent that items will be 
printed on top of the magstripe. Use this option to 
select if the magstripe is on top or on the bottom 
(for landscape printing) or on the left or right side of 
the card (for portrait printing) or that no cards with 
magstripe will be used.  
NB: For other sizes than the ISO card format, no 
magstripe indication can be displayed. 

 
Chip Positioning 

This option can give an indication where the chip will 
be positioned on the card. There are three options: 
front, back or no chip. Keep in mind that the 
positioning is just meant as an indication and only 
applicable for the selectable chip types. 
 

 
Paper tab: 
 

Type The dropdown list box includes all layout 
types that are supported. 

 
ISO-Card  86/54.5Select this if you want to design an ISO standard card  
   and you use a full size printer (edge to edge). 
ISO-Card  DNP Select this if you want to design an ISO standard card 
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 and you use a Dai Nippon CP410 or CP510 printer. 
ISO-Card Fargo Select this if you want to design an ISO standard card  
 and you use an older model Fargo printer. 
ISO-Magicard Select this if  you want to design an ISO standard card 
 and use an older model Magicard printer. 
A4 Select this if you want to design a layout for A4 paper  
 (if you print the layout on A4 paper it is possible to print 
 six or more records on one sheet).  
Mitsubishi 150/100 Select this if you have a Mitsubishi CP100 with 

sheets of 150x100 mm. 
Mitsubishi 110/110 Select this if you have a Mitsubishi CP100 with 

sheets of 110x110 mm. 
Manual Size If  you have selected ISO-card, you can define your own 

badge  size. The badge dimensions can now be filled in in the  
 dialogue. 

 
 Portrait   Define if the layout is in portrait. 
 Landscape Define if the layout is in landscape 
 

Size  The size is fixed for every card (or form) type, except for 
the    manual size. If the type is ‘Manual Size’ the size can be filled 
   in here. 
 
Badges per page The number of badges per page can be selected for the 
types A4 and Manual Size. Fill in the number of badges per row and per 
column, if you multiply these numbers, you will get the number of badges per 
page. 
 
Margins Margins can be set only if the type is A4. Left, right, top and  
  bottom margins can be set. 
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Top margin 

 

 
 

 
Space between The space between the badges
A4. In that case the space between rows and the sp
set (in millimeters). 
 
After clicking ‘OK’ the dialogue will be closed and th
with an empty badge layout. 
 
Now you will be ready to add the different items to 
 

5.1 Add items to the layout 

Under Add Item in the ‘Edit menu’, the following op
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Image 
 

 

 

Image Field 
Select one of the available image types (photo, signature, etc.) to add to the 
layout. 
 
Image Format 
Select the required image format. The following options are available: 

3*4 (image is scaleable in 3 to 4 ratio) 
4*1 (image is scaleable in 4 to 1 ratio) 
Custom format (image is scaleable in selected ratio) 
Free (image is free scaleable) 

 
 
Scale Type 
Allows you to define how the image is drawn in the rectangle defined by X start, Y 
start, Width and Height. 
Clip Destination On Source: The rectangle is fully covered by the image by 
enlarging the image so that the image width or height fits exactly in the frame 
width or height. The parts which are outside the rectangle are clipped. (No image 
distortion) 
Fit Source In Destination: The image size is reduced so that the width or 
height fits on the width or height of the rectangle. (No image distortion) 
Scale Source To Destination: The rectangle is filled with the image by resizing 
the image width and height to the width and height of the rectangle. (Image 
distortion) 

 
 Note: Choose the same value here as in the camera settings to get the 

best results. 
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X start 
Enter a value in millimeters for the starting point of this item in X direction. 

 
Y start 
Enter a value in millimeters for the starting point of this item in Y direction. 
 
Width 
Enter a value in millimeters for the item with. 
 
Height 
Enter a value in millimeters for the item height. 
 
Layer 
Select a layer for this item (ranging from layer 0 till 9).. 
Items with a high layer value will be placed on top of items with a low value.  
 

Static Text  

  
 
When you use this option you can add static text to the current badge layout. 

After selecting this option you see the following dialogue box: 

Data tab 

 
 

Type in the static data to put in the static text box. At the bottom of the dialogue 
in the preview box  this text will be displayed with the selected font and color. 

Use the ‘Word wrap’ option if the text you entered is too long for one line. Note 
that the preview is not suitable to determine how the lines will be wrapped. This 
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depends on the selected layout size and the width you reserve for the string. 
Finish the settings in the other tabs and click ‘OK’.   
When word wrap is used, the options ‘clipping’ and ‘automatic sizing’ (see 
position tab) will be disabled. The ‘textbox’ on the layout will only have two 
handles when the option ‘word wrap’ is enabled. Only the width can be changed, 
the height will be adjusted automatically to make the text fit into the box. 

 

 

 

Position Tab 

 

 
 

Position The position and the size of the text block on the badge layout. The 
text is positioned within a rectangle (text box). 

 X start = Start position on the X-(Horizontal) Bar 
 Y start = Start position on the Y-(Vertical) Bar 
 Width = Width of the text block to a 10th of a mm on the layout. 
 Height = Height of the text block to a 10th of a mm on the layout. 
Clipping         When checked, text outside the rectangle is clipped.  
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Without clipping (off),  With clipping (on), 
text inside and outside   only the text inside the box is visible.  
the box is visible. 
 
Use clipping to make sure that no other items will be covered with text. 
 

 Note:  Do not use clipping with Arabic text (right aligned) and italics (a part 
of the first character can be clipped). 

 
Automatic sizing  When checked, the box around text will be sized to fit 

exactly around the text in it. 
 

   
Without automatical sizing (off).  With automatical sizing (on). 
 
 
Layer Value 0 to 9. 
 Items can be placed on several transparent layers,  
 Items created with a high value will be placed on top of items with 

a low value. 
Orientation    Enables the user to rotate text in steps of 90 degrees. 

 
 

 Note:  When using special characters like Arabic text, don’t forget to use the 
corresponding character set (e.g. Arabic) instead of the default one, 
otherwise the characters will not be displayed correctly. 

 
Font tab  
Define the font in which the text will be displayed on the badge layout. 

 
Font  The name of the font to be used. 

Size  The size of the font. 

Character set Select the which character set from the used font should be used. 

Alignment Defines how the text is positioned within the text box, left, right or 
 centered. 
Effects  Determine with which effects the text is placed on the 
badge. 
 Underline = puts a line under the text 
 Strike Out  = puts a line through the text 
 Font Base  = The base line on which a font rests 

  
21 
 



BM 5500 
Version 6.1 SP2 

July 2006 
 
Color 
Click this button to get the Windows color dialogue. 
 

Dynamic Text 
Use this option to add dynamic text to the layout (text from a database field). 
 
The ‘Position’, ‘Font’ and ‘Color’ tab in the dialogue are identical to the ones in the 
‘Static Text’ dialogue (refer to the previous paragraph for a description of these 
items). 
Select the ‘Data’ tab to select a field (or a combination of fields) from the 
database. 
 

 
 

Click the ‘Select Field’ button to get a list of the available fields. 
Select a field and click ‘OK’ to confirm. If you click ‘Cancel’ no field will be 
selected. You can also type a string that can be built of one or more database 
fields in combination with constants. The “+” operator is allowed: 

 Add a database field to constant text: 
 
   “Company:”+COMPANY 
 
 Or to another database field,  
    
   ZIPCODE+CITY 
 
 Add a database field to another database field or to constant text, 

    spaces between the fields will not be displayed*.    
   
   FIRSTNAME + “ “ + LASTNAME  
 

Logo 
Use this option to add a logo to the layout: 
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Position The position and the size of the text block on the badge layout. The 

text is positioned within a rectangle (text box). 
 X start = Start position on the X-(Horizontal) Bar 
 Y start = Start position on the Y-(Vertical) Bar 
 Width = Width of the text block to a 10th of a mm on the layout. 
 Height = Height of the text block to a 10th of a mm on the layout. 
Layer Value 0 to 9. 
 Items can be placed on several transparent layers,  
 Items created with a high value will be placed on top of items with 

a low value. 
Scale Type Three options are available: free, actual size, keep aspect ratio. 

Free: logo is free scaleable. Actual size: logo will be displayed on 
layout in the actual size. Keep aspect ratio: size of logo can be 
scaled, but only within the original width/height ratio. These 
options are available as soon as a logo file has been selected. 

 
 
 

 
 

Locate Logo tab 
Click the ‘Get Logo File’ button to select a logo file (in BMP format). It is advisable 
to store the logos for BadgeCreator in the logos directory in the BM5500 folder to 
prevent that the logo file will be deleted by accident. 
If a dynamic logo is used (refer to description of DBLC module), select the 
dynamic logo field from the dropdown list. The fields marked in DBLC as dynamic 
logo fields (options ‘has pick list’ and ‘has logo’ enabled) can be selected from this 
list. Make sure the logos corresponding with the logo names in DBLC are available 
in Logos directory. 
 
Transparent Under the ‘locate logo’ tab the option transparent can be found. If 
this option is  selected, the logo will be made transparent. Note that the 
transparent option will work best with black and white logos. Colored logos will 
mingle with the background when they are made transparent. 
 

Barcode   
Adds a barcode that is dependent on the contents of a database field (depending 
on the barcode type, numeric, date or character fields can be used). 
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Use the ‘data’ tab to select a database field where the barcode will be based 
upon. This works in the same way as for ‘dynamic text’(see previous paragraphs). 
Use this tab also to indicate if the barcode has to be transparent or not. 
 
Click the settings under the ‘position’ tab to position the barcode on the layout. 
This works in the same way as the position of fixed and variable data (see 
previous paragraphs). The transparent option can be used to put a transparent 
barcode on top of a dark colored rectangle. In this way the barcode will be 
infrared readable, but cannot be copied. 
 
Type tab 

 

 
 
Barcode  This list specifies the available barcode types. Most of the general 
used   barcodes are available, including the 2 dimension PDF417 barcode.  
Bar code text Place (human readable text) below the bar code, above the bar 

code or use no text. 
BCT Font Define the font in which the human readable text will be displayed. 
Density Determines the width off the thinnest bar code stripe. 
Height Determines the height of the barcode layout in mm’s. 
Supplement Add a supplementary bar code. 
Stretch factor Determines the longitudinal length of the barcode as an addition 

to the  density setting. Note that the result of this setting is visible 
in the    Preview of BadgeMaker and on the printed 
cards, but not in the ‘Add    Barcode dialogue. 

Checksum In order to increase the reading accuracy, some barcode types can 
use checksums. The availability of a checksum is dependent on the 
barcode type. The calculated value is added to the barcode. 
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Line 
Position: 

 
With the X start and end value, the length of the line will be determined. 
With the Y start and end value, the angle of the line will be determined. 
 
Color: 
Use the ‘Color’ button to select a color to display the line. The line thickness can 
be adjusted in 10ths of a millimeter. 
 

Rectangle 
Use the ‘position’ tab to position the rectangle and to define the dimensions. 
Use the ‘color’ tab to define the color, the line thickness and if the rectangle 
should be solid or not. 
 

Circle 
Use the ‘position’ tab to position the circle by giving the coordinates for the center 
and the size of the radius. 
 
Use the ‘color’ tab to define the color, the line thickness and if the circle should be 
solid or not. 

 

Delete Item 
Use this option to delete the selected item from the layout. Before deleting the 
item, BC will ask for a confirmation (do you really want to delete this item?). 
 
Click ‘Yes’ if you are sure to delete the item.  
 

5.2 Editing existing items 

Click on an item to select it and then select Item from the Edit menu or double 
click on an item. The dialogue will look the same as when a new item is added. 
Now you can make the necessary adjustments. 

Select item from list 
Select item (Edit menu) enables the user to select and edit specific items (per 
layer) A screen appears, with the used layers marked. This option is particularly 
handy if items are positioned close together on the badge. In that case they are 
difficult to select by mouse. 

Clicking on one of the “+” marks will show the items associated with this layer 
and allow you to edit these particular items. If no “+” mark is displayed, no items 
are available on this layer. 
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Badge Layout  
Use this option from the ‘Edit menu’ to adjust the layout settings of the currently 
opened layout. The ‘Edit Badge Layout’ dialogue is similar to the ‘New Badge 
Layout’ dialogue.  

5.3 Often used tools in BadgeCreator 

In this chapter some tools are described that can help you to make the design of 
your badge easier. 

Snap to reference line 
In the ‘Options’ menu a reference lines can be set. Depending on the settings 
(left alignment, center alignment, right alignment etc.), items will be aligned to 
the horizontal or vertical reference line. 

View Menu 
The ‘View’ menu contains five options: 
Zoom in: Use this option to zoom in on the layout (details). 
Zoom out: Use this option to zoom out from the layout (overview). 
Center On Screen: Use this option to center the layout on the screen. 
Show Whole Badge: Use this option to fit the layout into the window. Use this 
option again (or press F11) if the window is resized. The size of the layout will be 
adjusted to the new size of the window. 
Layout side: Use this option to switch between the front and back of the card 
layout (only available for double sided badge layouts). 
 
Options menu, system settings: 

Default Font tab 
Use the ‘Select New Font’ button to select a default font, a default font size, 
default font style and default color for the static text and database fields. Also 
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defaults can be selected for the alignment and effects. When you click the ‘Select 
New Font’ button the Windows font selection dialogue will be opened. 

This option makes it possible to choose a default font, font style and font size. 
 

Zoom and Grid 
In the ‘Zoom and Grid’ dialogue the options zoom factor, grid resolution, snap to 
grid and show grid can be set.  

 

Reference Line 
There are three reference line options: 

No Reference Line  
No reference line will be drawn to align to. 
 
Vertical 
A vertical reference line will be displayed, starting at the X  position as 
given in. There are three ways to align: Left (the left side of the item 
aligns with reference line), Center (the center of the item aligns with the 
reference line) or Right (the right side of the item aligns with the reference 
line). 
 
Horizontal 
A horizontal reference line will be displayed, starting at the X position as 
given in. There are three ways to align: Top (the top of the item aligns 
with reference line), Center (the center of the item aligns with the 
reference line) or Bottom (the bottom of the item aligns with the reference 
line). 

 

Help  
Press the F1 button or select ‘Help Index’ from the ‘Help menu’ to open the 
BadgeCreator help file. Help can be found based on the option in the menu or on 
keyword.  

About BadgeCreator 
If you select this option from the menu, the about box will be displayed. 

The about box gives information about the version number and the license. The 
serial number displayed is read from the security dongle. This information is 
useful if you would need to contact the helpdesk. 

 

5.4 Working with the mouse and cursor keys 

Apart from the normal mouse functions, in BadgeCreator the mouse is used to 
position and resize items and to select items by double clicking them. 
 
A new feature is that more than one item can be selected with the mouse by 
using <CTRL-Left- Click>. The selected items can be moved, copied or deleted. 
 
The right mouse button is used to open the mouse menu. The following items will 
be available: 
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These items are also available in the regular menus. 
 
Cursor keys: 
It is possible now to move items on the layout by using the cursor keys (←↑↓→). 
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5.5 Button bar 

The button bar can be used to easily start a function, by simply clicking on the 
corresponding button. In general, the most frequently used options can be found 
here. 

 
 

 
 

 Login Click  on this button, to login to BM5500 and get 
access to the BM functions 

 Logout Click on this button, to logout of BadgeMaker and 
disable all other functions. After logging out, all BM 
files will be closed. You have no access to BadgeMaker 
data until you login again with a valid user name and 
password. 

 Open Layout Click on this button, to open an layout file that is linked 
to the currently opened BM file. 

 

 Send data Click on this button to send card data by email to a   
central office. 

 Preview Click  on this button, to preview the current record in 
the current layout on the screen.(front, back, 
encoding etc.) 

 

 Print  Click  on this button, to print the selection using the 
   current layout to a Windows supported printer.  
 

 Copy Click  on this button, to copy the active image of the     
current record to the clipboard.  

 Paste  Click on this button, to paste the image from the 
 clipboard to the active image of your current record.  

 Photo  Click on this button, to add an image of the selected 
 image type. 

 Bulk Input Click on this button to activate the bulk input module. 

 

 Import data 
 

 Add Record  Click on this button to add a record to the database. 
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 First Button  Click  on this button, to go to the first record in the 
 database. 

 Previous Button  Click  on this button, to go to the previous record in 
the  database. 

 Next Button  Click  on this button, to go to the next record in the 
 database. 

 Last Button Click  on this button, to go to the last record in the                               
database. 

 Find Button Click on this button to activate the find function. 

 

 SQL Select Button Click on this button to open the selection dialogue. 

 

 Chip encoding Click on this button to create a chip info file to do chip 
encoding with separate encode unit. 

 

 OMC encoding Click on this button to create an OMC info file to do 
OMC encoding with a separate OMC encode unit 
(special option). 

  

  About BM Click  on this button, to display the About box. 

 

 Help Click on this button to activate the help option. 

 

 

  
 Layout selection Click on this box to select one of the available layouts. 

 

 New badge Click this button to start the BC module to create a 
new badge. 

 

 Edit badge Click this button to start the BC module to edit the 
current badge layout. 

 

 Toggle card Click here to show or hide the card preview in the 
main dialogue. 

 Toggle front Click to show or hide preview of the front of the card 
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 Toggle reverse Click to show or hide preview of the reverse side of 
the card. 

 Toggle encode Click this button to show or hide the preview of the 
encode information 

 Show magnetic encode info 
  Click this button to show the magstripe encode 

information. 

 Show chip encode info 
  Click this button to show the chip encode information. 

 Scan single form Click this button to scan a single form with the 
automatic scan option. 

 Scan multiple forms Click this button to scan multiple forms with the 
automatic scan option. 

 Scan image only Click this button to scan an image from a form with 
the automatic scan option without recognizing the 
barcode. 
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6. Step 3, producing cards with BadgeMaker. 
When step 1 and step 2 are finished, the settings are made and layouts have 
been created. Now you are ready to produce cards. 

Advanced options like encoding, import and export, security settings and special 
print options will not be described. If you miss certain options, refer to the 
reference manual. 

6.1 Starting BM5500 

Select BadgeMaker from the “BM5500 32 bit edition” program folder. 
 
When you have started BM5500 click the ‘Login’ button, or select ‘Login’ from the 
‘User’ menu. The following dialogue will come up: 
 

 
 

To be able to open a project (BM file), you have to login first. The login dialogue 
will also come up, when you try to open a project (BM file) before logging in. 

Each user is a member of a group. The group determines the authorization level. 
If you stop working at the end of a day, you have to logout. 
 
User  Type your user name followed by  <TAB> or <ENTER> 
Password Type your password followed by  <ENTER> 

 
When using BadgeMaker for the first time : SUPERVISOR  as user name and 
SUPERVISOR as  PASSWORD will provide access to the system. It is advisable 
that the supervisor changes the password directly after login and create new 
users for the other levels. 
Now you can open a BM (project) file to get access to a database. 
If you typed in the wrong password, select ‘Retry’ to return to the ‘User Login’  
window, to try again.  
 
When the database is secured, you will be requested a second time for a user 
name and password after opening a BM file, to get access to the database. 
 

Open a project file 
 
When you select open, the open BM file dialogue will be displayed. 
Select a valid BM file and click the ‘Open’ button. If you did not login yet, the 
login dialogue will come up. In that case you first have to log in before the BM file 
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will be opened. When you are logged in, the Select data window will be displayed. 
With the options in this window all data or part of the database can be selected. 
 

 
 
A field name can be selected from the dropdown list, then an operator has to be 
selected from the next dropdown list (=, <, >, <=,  >=, <>, LIKE) and a value 
has to be filled in the ‘field value’ box. Select the type of selection AND or OR (for 
the first selection statement this does not matter yet) and click the ‘Add’ button 
to add the selection statement. This procedure can be repeated to add more 
selection statements. 

OK   Select the records on specified criteria. 
Select all Selects all the records (can take some time when working with a 
very   large database). 
Reset  Removes the current selection. 
Cancel  Closes the select dialogue, no selection will be made. 
 
Note: Click on SELECT ALL if you want to work with the entire database. In some 
cases opening a large database entirely may take a while, do not reset your 
system or the database may be damaged. 
 
After selecting the entire database or part of it, within the specified criteria, the 
main screen will be displayed. 
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The main screen can display the selected records, the different image types and 
the card preview. 
 
The first time you open a new project in BM5500 it might be necessary to select a 
layout first in order to see a layout preview.  
 

 

toggle front/back toggle card 
  

 
Click on the layout selection box to select one of the available layouts. 
BM5500 offers the possibility to display a constant preview on the right of the 
database window or a full screen print preview. 
To display the full size print preview, select ‘print preview’ from the ‘File’ menu or 
click the ‘print preview’ button.  
To display a constant layout click on the ‘toggle card’ button on the right of the 
layout selection box. Next to this button you can find the buttons to toggle the 
display of the front and the back of the card. 
For more information on the encode options refer to the full version of the 
manual. 
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Adjusting the database window 
You can adjust the size of the database window, the preview pane and the image 
window pane by moving your cursor to the vertical or horizontal separation bar. 
The arrow will change as indicated below. Hold the left mouse button down and 
move to the right, left, top or bottom to adjust the borders. 
 

  
 

 

6.2 Adding and editing data 

Add Record 

  

Depending on the use you make of the database, you will add records in 
BadgeMaker or will read only existing data. If you wish to add a new record click 
the ‘+ button’. Note: The add record option can be disabled by the administrator.  
The field edit dialogue will come up, where you can insert the new data. 

Edit Record 
When you  double click on a record the field edit dialogue will also be displayed. 
This time the fields will be filled. Depending on the settings made in de database 
management system and in DBLC fields can be edited, will be read only or will be 
invisible. Read only fields will be marked gray. 
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6.3 Adding images 

When the data has been entered, it is time to add photos and/or other images. To 
acquire an image you will need a capturing device. This can be a digital photo 
camera, a video camera in combination wih a capture board or a scanner. Most of 
these devices can be controlled with a TWAIN driver or a direct driver. Use the 
‘select source’ option from the ‘image’ menu to select a driver. 
 

Select source 
Use this option to select a driver for your image capture device. First select the 
image type from the list for which you wish to select the driver. Then select a 
direct driver from the dropdown list or click the ‘Twain’ button to display a list 
with the installed Twain drivers. Select a driver and click ‘OK’. 
 

Acquire... 
Use this function to add an image to the image database. The image type that 
will be acquired is equal to the type of the active image window. Click on the 
window of the desired image type to make it active. The input source to acquire 
an image, can be selected under ‘Select Source’ (also in the Image menu). 
 
If ‘Image File’ is selected (default) as image source, the following dialogue will 
come up when acquiring an image: 
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In this way graphic files of different formats can be selected and linked directly to 
the current record. Keep in mind that the graphic files already must have the 
correct height/width ratio to show on the Badge Layout (to prevent parts will be 
cut of). 
 
Use the ScreenCheck Image File grabber (optionally available) if your graphic files 
should be cropped and/or rotated. The ScreeenCheck Image File grabber supports 
various height/width ratios. 
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6.4 Printing cards 

Print  preview 

  
When a layout is selected and the database is filled a card can be printed. To 
check the result in advance you can use the ‘print preview’ command to switch 
from the active file to a print preview. 
With Print Preview, you can see how the current (or the first selected) badge will 
look like when you print it. From the preview dropdown menu you can choose a 
view of .. 
 

     
   the front of the badge   and the back .. 
 
Select  ‘Close’ from the Window menu to close the preview window. 

Print 

  
Use this command to print badges from the selected records, current record or all 
records. 
 
 Shortcut: CTRL P 
 
If you choose this option you will see the following dialog box (normally a direct 
card printer will be selected): 
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Select the print range and click ‘OK’. You can change the properties of the printer 
driver by clicking the properties button. 
 

Print Setup 
Enables the user to setup the printer for printing in BM5500: 

List setup  
Use the left mouse button to select the fields to be printed. The selected fields will 
be printed in columns next to each other in the order as they appear in the list. 

 

 

. 

 

Print List 
Use this function to print a list of the selected records. Make sure you selected 
the correct fields to be printed in ‘List setup’. If many fields are selected, print in 
landscape, otherwise the other columns will be printed on a next page. To print a 
badge use the ‘Print... ‘ option. 

6.5 Often used functions in BadgeMaker 

File menu 

• Recent Files: The four last opened project files will be displayed for easy 
opening. 

• Close: Use this option to close the current project file. BM5500 will not be 
closed, the current user is still logged in. 

• Exit: Select this option to exit BM5500. 

 

Record menu 

• First, Next, Previous, Last: 

  
Use this command to go to the first, next, previous or last record of the 
selection, as displayed in the grid. 

• Find: 

  
39 
 



BM 5500 
Version 6.1 SP2 

July 2006 
 

  
Use this option to search one or more records from the current database 
that matches the find statement. After finding these records only these 
records will be displayed. To return to the initial selection click the ‘Sort 
button’. 
You can also search on the contents of a field by pressing  the ‘F3’ key on 
your keyboard or clicking on the search line. 
The find option will search in the selected record set. However if the  = 
(equal sign) is used, the find option will search in the whole database. This 
enables the user to work with a predefined record set, but adds the 
flexibility to search for a particular record in case of an urgency (a new 
card has to be issued at once). 

 
Field name  
The dropdown menu enables the user to select a field name on which the 
sorting is based. 
 
Operator 
The =, <, >, >=, <=, <> or LIKE operators are used in correspondence 
with the selected field value. 
 
Field value 
Fill in the value to search for, or use the drop down list to select a value of 
an earlier find action: 
 

 
 
 
Example: 
For searching ‘Johnson’ in the Database click to show the dropdown list 
under Field name.  
Select Person name, type “Johnson” in the Field Value edit box and choose 
the “ = “ operator. 
The specified field value “Johnson” enables the database  to be searched 
for this particular field-value. 
 
Sort button: 
To sort the database on the selected field click the ‘Sort’ button. To sort on 
another field, select the field from the field name drop down list and click 
the ‘Sort button’. After using the ‘Sort button’ the initial selection (made 
with ‘SQL select’) will be displayed again. 

 
• SQL Select...: 

With this function you are able to select or deselect a group of records.  
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You can also start SELECT window  by clicking the right mouse button on 
the grid , and choose select from the dialog window (or the F7 function 
key). 
 

 
 
A field name can be selected from the dropdown list, then an operator has 
to be selected from the next dropdown list (=, <, >, <=,  >=, <>, LIKE) 
and a value has to be filled in the ‘field value’ box. Select the type of 
selection AND or OR (for the first selection statement this does not matter 
yet) and click the ‘Add’ button to add the selection statement. This 
procedure can be repeated to add more selection statements. 
It is also possible to select a predefined selection (four presets are 
available). Refer to ‘Predefined conditions’ for an explanation how to 
define the presets.  
 
OK   Select the records on specified criteria. 
Select all Selects all the records (can take some time when working 
with a very   large database). A confirmation will be asked if you 
are sure you want   to select all records. 
Reset  Removes the current selection. 
Cancel  Closes the select dialogue, no selection will be made. 
 
 
 

• Tag all: 
Use this option to tag all records in the selection. Tagged records can be 
used to print cards, export or to print a list from. 
 

• Remove tags: 
Use this option to remove all tags from the records. 
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Image Menu 
  

• Activate 
Select this option to make one of the available images the active image. 
When selecting ‘Acquire’ or clicking the ‘photo button’, the acquired image 
will be stored under the active image type. 

• Copy 

   
Use this command to copy the current photo onto the Clipboard. Copying 
photos to the Clipboard replaces the contents previously stored there. 
 
You can use this function to import pictures from your database into a 
Word document or another database. 
 
 

• Paste 

  
Use this command to insert a copy of the Clipboard contents at the 
insertion point. This command is not available if the Clipboard is empty. 
You can use this option to copy a photo from another database. 

 

System menu 

• Setup 
Use the setup (system menu) to specify the workstation settings, Int2of5 
barcode settings, auto import settings and the mail settings. When you 
start with BadgeMaker, normally you can use the default settings. For 
more information on the settings refer to the full version of the manual. 
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